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The purpose of
visualization

IS “Insight’,
not pictures.”

~Ben Shneiderman
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“Insight” Leads to . .
Discovery
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“Insight” Leads to . .

Visualizing Patterns
over Time
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“Insight” Leads to . .

piscovery

Spotting
Differences




“Insight” Leads to . .

piscovery

Spotting
Differences
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http://www.kidsfront.com/spot-differences/9.html



“Insight” Leads to . .
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Spotting Differences

How many
/’'s do you
see?
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“Insight” Leads to . .

Allows users to
answer guestions
they didn’t know
they had

.
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Proteins act alone
or in complexes to
perform many cellular

functions

‘2','\ _."

genome,
cell

<hromosonus

proteins ..

Genes contain
instructions
for making
proteins

From Genes to Proteins

Human Genome Project
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“Insight” Leads to . .

The Challenger
Disaster

httr;://en.’\‘Nikipedia.org/wiki/33 PURDUE

File: Challenger_explosion.jpg



“Insight” Leads to . .

Visualizing Spatial Relationships

http://datafl.ws/197

http://datafl.ws/198

Muehlenhaus, I. (2012). Chapter 8, Visualizing Spatial Relationships, Visualize This: PURDUE

The Flowing Data Guide to Design, Visualization, and Statistics, pp 271-326. POLYTECHNIC




Gan anyone think of another
reason why “insight” Is
important?
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“Insight” Tells a Story.

The use of visualization in the
analysis of pollution and air flows In
Manhattan, New York City
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Courtesy of RENCI, University of North Carolina at Chapel Hill.




“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard
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“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard
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“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard
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“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard
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“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard
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“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard
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“Insight” Tells a Story
Napoleon's Invasion of Russia in 1812 By Jacque Minard

Best Statistical Graphic, Ever! Army Size:
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Visualization Applications

Biovisualization
(BioVis)

The visualization of
biological data;

Often grouped with
computer animation
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Information Visualization

(InfoVis) (5 b

Interdisciplinary O (e
| -
Study of the “visual Uhﬂ InfoVis

representation of
large-scale collections
of non-numerical
Information

Internet Usage | e T T e T B T
Source: http://www.cernea.net/wp-content/uploads/2013/03/internet.gif

Relative IPs



http://www.cernea.net/wp-content/uploads/2013/03/internet.gif

Visualization Applications

Geographic Visualization
GeoVis

Communicates geospatial information in
ways that, when combined with human
understanding, allow for data
exploration and decision-making
processes.

MacEachren, A.M. and Kraak, M.J. 1997 Exploratory cartographic visualization:
advancing the agenda. Computers & Geosciences, 23(4), pp. 335-343.

Jiang, B., and Li, Z. 2005. Editorial: Geovisualization: Design, Enhanced Visual Tools
and Applications. The Cartographic Journal, 42(1), pp. 3-4

MacEachren, A.M. 2004. Geovisualization for knowledge construction and
decision support. IEEE computer graphics and applications, 24(1), pp.13-17
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https://en.wikipedia.org/wiki/Alan_MacEachren

Visualization Applications

Scientific Visualization

(SciVis)

Primarily concerned with the

visualization of three-dimensional
phenomena
Emphases on realistic renderings
of volumes, surfaces, illumination
sources, etc.

http://www.tinkering.net/sciviz/
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Visualization Applications

Scientific Visualization

(SciVis)

The focus of this workshop

Primarily concerned with the

visualization of three-dimensional
phenomena
Emphases on realistic renderings
of volumes, surfaces, illumination
sources, etc.

http://www.tinkering.net/sciviz/
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High Level Querview
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When do you think ahout
visualizing your data2
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e S

acquire —— parse —— filter —— mine —— represent —— refine —— interact

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)



obtain the data

e S

acquire —— parse —— filter —— mine —— represent —— refine —— interact

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)



obtain the data

l g e T

acquire —— parse —— filter —— mine —— represent —— refine —— interact

W

provide
structure

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)



remove all but
the data of

) interest
obtain the data

l v,
A N s

acquire —— parse —— filter —— mine —— represent —— refine —— interact

\t\—)é—’/

provide
structure

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)



remove all but

the data of
obtain the data Interest
o —

acquire —— parse —— filter —— mine —— represent —— refine —— interact

e S,

provide
structure

apply methods from statistics
or data mining to discern
patterns or place the data in
mathematical context

PURDUE

POLYTECHNIC

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment
by Ben Fry, O’Reilly (p 15)



choose a basic

remove all but visual model,
the data of such as a bar
_ interest i
obtain the data graph, list or tree
e Z—

acquire —— parse —— filter —— mine —— represent —— refine —— interact

*/%_/’/

provide
structure

apply methods from statistics
or data mining to discern
patterns or place the data in
mathematical context

PURDUE

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)




choose a basic

remove all but visual model,
the data of such as a bar
_ interest i
obtain the data graph, list or tree
e Z—

acquire —— parse —— filter —— mine —— represent —— refine —— interact

B S e, -

provide
structure : :
improve the basic
apply methods from statistics  representation to
or data mining to discern make it clearer and
patterns or place the datain  mgre visually
mathematical context engaging
Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC

by Ben Fry, O’Reilly (p 15)



choose a basic Add methods for
remove all but visual model, manipulating the
the data of such as a bar data or controlling
, interest : what features are
obtain the data graph, list or tree it
l v v ‘i'
//\ Y

acquire —— parse —— filter —— mine —— represent —— refine —— interact

provide
structure

improve the basic
apply methods from statistics representation to

or data mining to discern make it clearer and
patterns or place the datain  more visually
mathematical context engaging

PURDUE

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)




' . choose a basic Add methods for
An iterative process remove all but visual model, manipulating the
the data of such as a bar data or controlling
_ interest i what features are
obtain the data graph, list or tree visible
l v, \ ‘i'
//\ /\

acquire —— parse —— filter —— mine —— represent —— refine —— interact

provide
structure

improve the basic
apply methods from statistics representation to

or data mining to discern make it clearer and
patterns or place the datain  more visually
mathematical context engaging

PURDUE

Adopted from Visualizing Data: Exploring and Explaining Data with the Processing Environment POLYTECHNIC
by Ben Fry, O’Reilly (p 15)




Visualization Process

Taking raw data and converting it to a form that is viewable
and understandable to humans.
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Adopted from The ParaView Tutorial, The Basics of Visualization, version 3.98



Visualization Process

There are several steps between raw data and a
finished visualization
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Why do we care?
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» Data visualization is becoming an increasingly important
component of analytics in the age of big data (SAS: Five
big data challenges and how to overcome them with
visual analytics)

http://www.sas.com/resources/asset/five-big-data-

challenges-article.pdf

Between now and 2020, the information in the Digital
Universe will grow by a factor of 44; the number of “files”
In it to be managed will grow by a factor of 67

Gantz, J., and Reinsel, D. (2012). The Digital Universe in 2020: Big Data,
Bigger Digital Shadows, and Biggest Growth in the Far East. IDC IVIEW,
Sponsored by EMC Corporation

PURDUE

POLYTECHNIC



http://www.sas.com/resources/asset/five-big-data-challenges-article.pdf

When should you think
about visualizing your
datasd

As early as possible
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& https://polytechnic.purdue.edu/vis/reu

;PURDHE VisREU Site

LY

Research Experience for Undergraduates in Sponsored By
Collaborative Data Visualization Applications

Purdue Polytechnic Institute Computer Graphics Technology Department invites undergraduates
with an interest in visualization to participate in cutting-edge undergraduate research at

Purdue University. VisREU Cohorts

The VisREU Experience: 8-Weeks, Paid Research, Professional Development, Network
Building, Developing Lifetime Transferrable Skills VisREU Newsletter

Volume 1

Volume 2 Issue 1 (2 MB)
7 Volume 2 Issue 2 (13 MB)
Book of Abstracts

What is Visualization

Visualization is the process of transforming raw data into a visual representation of relationships
that exist within the data. Visualization leads to insight, better understanding of relationships
between variables that exist in the data. Regardless of your academic major, at some point during
your academic life you will have a need to visualize something. The VisREU Site is the perfect
opportunity to learn about the visualization pipeline, applications and tools to help you create REU Site: Collaborative Dsta
impactful visualizations. Visuakiation Appications

About the Program
The program identifies research collaborators with visualization needs and assigns each student to a
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Visualization is the tool that will take us
forward from the traditional output of high
performance computing (HPC) that we are
used to into a visual medium that allows

researchers to collaborate and elaborate on
the finding's they’ve got.

Tim Carroll

Director and Global Lead,

Dell Research Computing Solutions
HPC Source (Spring 2011)
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* Primarily concerned with the visualization
of three-dimensional phenomena
(architectural, meteorological,
medical, biological, etc.),

PURDUE
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Wikipedia.com


http://en.wikipedia.org/wiki/Three-dimensional_space
http://en.wikipedia.org/wiki/Biological_Data_Visualization

* Primarily concerned with the visualization
of three-dimensional phenomena

(architectural, meteorological,
medical, biological, etc.),

* Where the emphasis is on realistic
renderings of volumes, surfaces,
Illumination sources, and so forth, perhaps
with a dynamic (time) component.
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http://en.wikipedia.org/wiki/Three-dimensional_space
http://en.wikipedia.org/wiki/Biological_Data_Visualization

Scientific Visualization Pipeline

——————— Produce Input Data

J ———————— Analyze, Filter, Reformat

@ W, i

Missing? -

Apply Sci Vis Techniques

1 ________ Map to Geometry
@er Graph@

L ———————— Render, Postprocess
Qmage datD

t ——————— View Results
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http://www.bu.edu/tech/research/training/tutorials/introduction-to-scientific-visualization-tutorial/the-scientific-visualization-pipeline/

scientific Visuahization Pipeline

_______ Produce Input Data
< Input Data>
L— ——————— Analyze, Filter, Reformat
Prepared DD
L— ——————— Apply Sci Vis Techniques
Sci Vis Model DatD
———————— Map to Geometry

L ———————— Render, Postprocess

——————— View Results
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Scientific Visualization

. R S Produce Input Data >
Pipeline: Step 1 . . . @b T

» Simulated Data

» Images

» Numerical

» Some measured value
» Observed Phenomena

1
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Scientific Visualization Pipeline:
Step 2. ..

> Cleanlng up the data CS— - - Produce Input Data
Input Data
- Removing noise "

mmm 7 Analyze, Filter, Reformat

- Replacing missing e —

values
« Clamping values to be r
within a specific range
of interest
» Performing
operations to yield
more useful data

Adopted from
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Scientific Visualization Pipeline: Step 3

. . S Produce Input Data
» Converts raw information @

i ntO som eth I n g more - Analyze, Filter, Reformat

\

understandable pepmedoan

“““ 7 Apply Sci Vis Techniques

! A
\———/
Sci Vis Model Data

» Visually extracting meaning
from a scientific data set
using various techniques
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Scientific Visualization Pipeline: Step 3

. . S Produce Input Data
» Converts raw information @

i ntO som eth I n g more - Analyze, Filter, Reformat

\

understandable pepmedoan

“““ 7 Apply Sci Vis Techniques

! A
e EE——
Sci Vis Model Data

» Visually extracting meaning
from a scientific data set
using various techniques

9 Vil e, | s =

Contour Clip Threshold Glyphs Streamlines
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Scientific Visualization Pipeline
Step 4. ..

Map to Geometry

——————— Produce Input Data

Cell Data » Scalars, ©

O nput Data
0 Q vecto rS’ Tt Analyze, Filter, Reformat
Q‘ Q tensors repretons
“0 > 1 D 2 D 3 D | Apply Sci Vis Techniques
y y
A R =
Point Data
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Scientific Visualization Pipeline:
Step 5. ..

Render, Post Process

——————— Produce Input Data
Input Data
Data _
Representation P —— Analyze, Filter, Reformat
Y @ U i Apply Sci Vis Techniques
Iteration ‘>
Visualization Sci Vis Model Data
Primitives and
Refinement © . - - - - - - - Map to Geometry

Computer G@

Render, Postprocess
Graphic -
Primitives Image data
Adopted from
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Scientific Visualization Pipeline:
Step 6. ..

——————— Produce Input Data
Output from =
. nput Data
ParaView
A Analyze, Filter, Reformat
i A . 0 - - Apply Sci Vis Techniques
Parallel Coordinates @@
Pseudocolor Rendering
Vector / TensorGlyphs |7 T T T 7 7 77 Map to Geometry
T Render, Postprocess

Image data

e
—=

_____ — View Results

Streamlines Volume Rendering
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Large data produced by large simulations produce
large visualization results and require large
visualization resources

Terabytes of ALEEAST Gigapixel
Terabytes of
data . Images
Vis
Resampling, Resolution to Capture
Application, ... Feature Detail
PURDUE
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Open source,
multiplatform

Supports distributed
computation models

Extensible modular

architecture

Available for 3D
computer graphics,
Image processing and

visualization

AL

%/lﬂ

Vistalzatlo,
\\ ool

Collection of C++
libraries

Leveraged by many
applications

Divided into logical areas
* Filtering

 Information Visualization

« Volume Rendering

Cross platform, using
OpenGL

Wrapped in Python, Tool
Command Language
(Tcl) and Java

PURDUE

POLYTECHNIC




Visualization ToolKit (UTK]

ParaView Is an end-user application with
support for

Para
Para
Para
Para

@ @ d D

Data Archiving
Reading
Processing
Rendering

Single node, Client-Server, MPI Cluster
Rendering

lll ParaView PURDUE
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Introduction to Scientific
Visualization Using

lll ParaView

\ 4
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lll ParaView

« Multi-platform parallel data analysis and
visualization application

« Mature, feature-rich interface
* Good for general purpose, rapid visualization

g
‘ /4 (L]
Q y ),,’ \
Mac L
Linux

Windows
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IilPara View

« Open Source ... It's Free!
* http://www.paraview.org/
* Built upon the Visualization Toolkit (VTK) library
* Primary contributors:
> Kitware, Inc. V& Towl
» Sandia National Laboratory
»Los Alamos National Laboratory
»Army Research Laboratory

71 s Visuallizziion
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http://www.paraview.org/

lﬂlPara View

A
s

-

. -"f.

Uniform Rectilinear (Image Data)

A uniform rectilinear grid is a one- two-
or three- dimensional array of data. The
points are orthonormal to each other and
are spaced regularly along each direction.

Grid — regular structure, all voxels
(cells) are the same size and
shape

PURDUE
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Curvilinear (Structured Grid)
Curvilinear grids have the same topology as
rectilinear grids. However, each point in a
curvilinear grid can be placed at an arbi-
trary coordinate (provided that it does not
result in cells that overlap or self intersect).
Curvilinear grids provide the more compact
memory footprint and implicit topology of
the rectilinear grids, but also allow for much
more variation in the shape of the mesh.

Curvilinear —regularly
gridded mesh shaping
function applied

Adopted from The ParaView Tutorial, The Basics of Visualization, version 3.98

IlpParaview Supporied Data Types
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Il paraview supported Data Types

7 Unstructured Grid
Unstructured data sets are composed of
points, lines, 2D polygons, 3D tetrahedra,
and nonlinear cells. They are similar to
polvgonal data except that they can also
represent 3D tetrahedra and nonlinear cells,
which cannot be directly rendered.

Unstructured grid — irregular mesh
typically composed of tetrahedra,
prisms, pyramids, or hexahedra

POLYTECHNIC

Adopted from The ParaView Tutorial, The Basics of Visualization, version 3.98



IlpParaview Supporied Data Types

Point data
Polygonal data
mages e 'g"” "
Multi-block | "i—;
Adaptive Mesh e
Refinement (AMR)

Time series support

PURDUE
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Isosurfaces Iil ParaView

Cutting planes
Streamlines
Glyphs

Volume rendering
Clipping

Height maps

& more

PURDUE
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Ilparaview SPECIAL FEATURES

Supports derived variables
Scriptable via Python
Saves animations

Can run in parallel / distributed mode for large
data visualization

CCCCCCCCCCC



J8paraview SUPPORTED FILE FORMATS

e ParaView Data (.pvd)

e VTK (.vtp, .vtu, .vti, .vts, .vtr)

e VTK Legacy (.vtk)

e VTK Multi Block (.vtm, .vtmb,
vtmg, .vthd, .vthb)

e Partitioned VTK (.pvtu, .pvti,
.pvts, .pvtr)

e ADAPT (.nc, .cdf, .elev, .ncd)

e ANALYZE (.img, .hdr)

e ANSYS (.inp)

e AVS UCD (.inp)

e BOV (.bov)

BYU (.g)

CCSM MTSD (.ne, .cdf, .elev,

xncd)

CCSM STSD (.nc, .cdf, .elev,

1ncd)

CEAucd (.ucd, .inp)

e CMAT (.cmat)

CTRL (.ctrl) .
Chombo (.hdf5, .h5) .
Claw (.claw)

Comma Separated Values (.csv) o
Cosmology Files (.cosmo, .gad-
get2) .

e Curve2D (.curve, .ultra, .ult, e
u) .
e DDCMD (.ddemd) .
e Digital Elevation Map (.dem) e
e Dyna3D(.dyn)
e EnSight (.case, .sos) .
e Enzo boundary and hierarchy e
e Exodusll (.g, .e, .exe, .ex2 e
ex2v.., etc) .
e ExtrudedVol (.exvol) .
e FVCOM (MTMD, MTSD, Par-
ticle, STSD) .
e Facet Polygonal Data .
L ]

Many more. ..

ProSTAR (.cel, .vrt)

Protein Data Bank (.pdb, .ent,
pdb)

Raw Image Files

Raw NRRD image files (.nrrd)
SAMRAT (.samrai)

SAR (.SAR, .sar)

SAS (.sasgeom, .sas, .sasdata)
SESAME Tables

SLAC netCDF mesh and mode
data

SLAC netCDF particle data
Silo (.silo, .pdb)

Spheral (.spheral, .sv)

SpyPlot CTH

Spy Plot (.case)

Stereo Lithography (.stl)

TFT Files

TIFF Image Files

TSurf Files

PURDUE
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 All processing operations (filters) produce data
sets

« Can further process the result of every operation
to build complex visualizations

« Extract a cutting plane,
* Apply glyphs (i.e. vector arrows) to the result

—Gives a plane of glyphs through your 3D
volume
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DEMONSTRATION

« WRF weather
forecast data set

» Rectilinear grid

» Multiple scalar
and vector
variables

» Time series
 Can show:

» Clouds

» Wind

» Temperature




Three Basic Steps:

* First your data must be read into
ParaView

* Next, you may apply any number of
filters that process the data to generate,
extract, or derive features from the data

 Finally, a viewable image Is rendered
from the data
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Let's get started....
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STOP!

This means YOU.

Sanity Check T¢

N\
v Software Installed? ~&)
v Data Sets downloaded?
v Canyou locate the datasets?

http://web.ics.purdue.edu/~vbyrd/trainingData.html
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http://web.ics.purdue.edu/~vbyrd/trainingData.html

Tutorial Datasets

» RectGrid2.vtk
» headsq.Vti

Sample data file

»header.txt
»XCoordinates.txt
»yCoordinates.txt
»zCoordinates.txt
»lookUpTable.txt

PURDUE
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What are we going to do?

» Load Data File

» Extract Isosurfaces from the data

» Create contours, clip contours, slice contours
» Volume Rendering

» Saving your Data

» Getting your data into Paraview

» Introduction to ParaView and Python Scripting
» Additional Resources
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Open Data File: RectGrid2.vtk

» Locate
RecGtrid2.vtk

» Click File =
Open

> Select
RectGrid2.vtk

» Click OK

M ParaView 5.00 64-bit e~

File Edit View Sources Filters Tools Catalyst Macros Help

I @ E: :'7'“ ﬂ“? r (;cb ’c“ vl :‘ "";)

Pipeline Browser g x

e B8 oa 2 FuA KAP DS mmo " B
H e ¢ e = :]XR& s AL Eeed

ﬁhlu

@ '_j RectGrid2.vtk

Properties Information

| Properties

| [ aonly ][ @ reset || 3 pelete |

m
x

Search ... (use Esc to dear text)

el
R
m-m

Edit Axes Grid .

.ﬁ’g v}
LE D g

Dc nter Axes Visibility
Orientation Axes

[] Crientation Axes Visibility

Background

[single color -
[ @ color | [Restore Defauit]

RenderViewl [I)(E)O)(&](X]
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Open Data File: RectGrid2.vtk

» Locate
RecGtrid2.vtk

» Click File =
Open

> Select
RectGrid2.vtk

» Click OK

» Click Apply

Ml ParaView 5.0.0 64-bit . - - =RREn A
File Edit View Sources Filters Tools Catalyst Macros Help

P BEOE 2 F R KA DM " E

H 2 ¢ e T A s 3 d s Peea

I@E {’.*ﬂn;‘*r Q“’?‘ & \ |__,_|L s O o

Pipeline Brow a

ﬁ builtin: RenderViewl [I)(E)O)(&](X]

@ '_j RectGrid2.vtk

opeLtie & x

) Reset *Dlhe.

uIte oo to clear text)

m-m
cww |)8)S
m-m-

Edit Axes Grid .

_@iiﬂ

Dc nter Axes Visibility
Orientation Axes
[] Crientation Axes Visibility

Background
[single color -]
[ @ color | [Restore Defauit]
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M ParaView 5.0.0 64-bit - B

File Edit View Sources Filters Tools Catalyst Macros Help
% © ?2 F D K D> D> DT e 0o B
ioane ]RGS MEEAAL

Rendenview1 (m][E)0)(5)

Properties

Properties

Colori
@ Solid Color

Point Gaussian

Gaussian Radius




Sample rectilinear grid

# vtk DataFile Version 2.0

Sample rectilinear grid

ASCITDATASET RECTILINEAE GRID

DIMENSIONS 47 33 11

X _COORDINATES 47 float

-1.223%6 -1.17188 -1.11979 -1.06771 -1.01562 -0.963542
-0.911458 -0.B59375 -0.807292 -0.755208 -0.703125 -0.651042
—-0.598958 -0.546875 -0.494792 -0.442708 -0.390625 -0.338542
-0.286458 -0.234375 -0.182292 -0.13020% -0.078125 -0.026042
0.0260415 0.078125 0.130208 0.182291 0.234375 0.286458
0.338542 0.390625 0.442708 0.494792 0.546875 0.598958
0.651042 0.703125 0.755208 0.BO07292 0.B59375 0.911458
0.963542 1.01562 1.06771 1.1197% 1.17188

Y COCRDINATES 33 float

-1.25 -1.171BB -1.09375 -1.015&2 -0.9375 -0.85937%

-0.78125 -0.703125 -0.625 -0.546875 -0.46875 -0.350625
-0.3125 -0.234375 -0.15625 -0.078125 0 D.07812%5

0.15625 0.234375 0.3125 0.390625 0.46875 0.546B75

0.625 0.703125 0.78125 0.859375 0.9375 1.01562

1.09375 1.17188 1.25

£ _COOCRDINATES 11 float

0 0.1 0.2 0.3 0.4 0.5

0.6 0.7 0.75 0.8 0.9

POINT_DATR 17061

SCALARS =scalars float

LOOKUP_TABLE default

0Co0OO0DO0OO0OOD
00000 oD0
0Co0OO0DO0OO0OOD
ooo0o0O0OO
00000 oD0




Greate Isosurfaces
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Create Isosuriace

Click on
RectGrid2.vtk

Select

> Filters

» Common
» Contour

_.U.*_A.',,'r.‘..,_ — ! » [ 5
TN o T
@ O Material Analysis L

M ParaView 5.0.0 64-bit P e " )
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> Select the value

In the Value
Range window
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> Select the value

In the Value
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' Apply
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Click the Add a range of
values button
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Click the Add a range of
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Click the Add a range of
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Should see

» Arange of
values in
the Value
Range box

» Values
range from
the min
and max
values
entered in
the
previous
dialog box
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Should see

» Arange of
values in
the Value
Range box

» Values
range from
the min
and max
values
entered in
the
previous
dialog box
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CREATE ISOSURFACES

SUMMARY OF STEPS

» Click Filters 2> Common

- Contour

> Remove all values in
Value Range Box

» Click Add a range of

values

» Set values (Or accept

default)

» Click Apply
» Set Color By property:
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Clip - Intersects the geometry with a half
space. The effect is to remove all the
geometry on one side of a user-defined
piane.
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CLIP ISOSURFACES
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» Make sure Contour 1 is
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+Y
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Create a
new Clip
filter:
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Create a
new Clip
filter:

Select:
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Create a
new Clip
filter:

Select:
> Filters
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Create a
new Clip
filter:

Select:
> Filters
» Common
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Create a
new Clip
filter:

Select:

> Filters

» Common
» Clip
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POSITION THE GLIPPING PLANE

» Using the mouse, hover over the arrow head (will
change color — red)

* Press the mouse button, keep it pressed and
rotate the clipping plane; arrow points out of the
screen towards you
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When done: Click Apply



> Click the

Inside Out
box to
switch the
clipping
plane

» Click Apply
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CLIP ISOSURFACES

SUMMARY OF STEPS

> Click +Y view button

> Click Filters> Common
- Clip

» Position the clipping
plane (move arrow point
to desired position)

» Click Apply

» Check Inside Out check
box to switch the
clipping plane view
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slice - Intersects the geometry with a
plane. The effect is similar to clipping
except that all that remains IS the geometry

where the plane is locatedl.
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» Make visible
»RectGrid2.vtk
»Clipl

»To make an object
visible click the eye
icon to the left of the
object

» Contour 1 should
NOT be visible for the
next task
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SLIGE ISOSURFACE

M ParaView 5.0.0 64-bit
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Should see

» Slicel object
in Pipeline
Browser

» Slicing Plane
with arrow in
3D window
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Position the
slicing plane
(move arrow
point to desired
position)

Click Apply
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You can move the slicing plane along
the axis to see a different slice

Click Apply to see changes
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SLIGE ISOSURFACE

SUMMARY OF STEPS

Select Clip1 Object
Select Filter

Select Common
Select Slice

Position Slicing Plane
Click Apply

YV V V YV V

Slice - Intersects the
geometry with a plane. The
effect is similar to clipping
except that all that remains is
the geometry where the plane
is located
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Background

[Single color - ]
E. Color |v] [Resmra Dafault]

Undo Create 'Glyph'

Properties [
# Apply P Reset 3 Delets
Search ... (use Esc to dear text)
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Recall Three Basic Steps:

» First your data must
be read into
ParaView

» Next, you may apply
any number of filters
that process the data
to generate, extract,
or derive features
from the data

» Finally, a viewable
Image is rendered
from the data

Opened simple data file
RectGrid2.vtk

Applied filters:
Contour, Slice, Clip

PURDUE
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Let's try a more complex

PURDUE

CCCCCCCCCCC




In preparation for the next section

You should be here

ParaView 5.0.0-RC2 64 [ [ E ety
> Delete all objects inthe  |T=conorioss oo
. . TR - e RE s Ld ik Feea
Pipeline Browser TTILITYIPT ”
Poeine Browser 8 x [ Olsyouts1x | 4 |
8 buitn: [EXIEY W1 Renderview1 (1)E)0)(8)(X)

» Select an object in the
Pipeline Browser

> Click the Delete button —
(or right click, then H
Delete) e

> To select multiple objects  |== .
press and hold the CTRL
key while selecting
objects

PURDUE
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Locate File: headsq.vti

File

Open

headsq.vti

Look in:

[F 1 [ParaviewTutorialData/

| Desktop
, Favaorites

J Dy
;BN
i =AY
Y

oy

. My Documnents =

Filename

.. SampleFile

4 RectilinearGrid.vtk
can.ex?
disk_out_ref.ex2

> headsqg.vti

n.h

T

F

1

Desktop

testRectilinearGrid_cyrush2.wvtk

File name: headsqg. vt

ok |

Files of type: |Supported Files (inp ®.cgns =.cml *.csv =txt *.C5V =TT *dem *.« v] [ Cancel

)




lll ParaView

»New Object in
Pipeline Browser

»Click Apply

E
B ParaView 5.0.0-RC2 64-bit

pBBE v ?

|l e

Pipeline Browser

File Edit View Sources Filters Tools Catalyst Macros  Help

FRN KAD> DM EB meo =
fi ] ErTT e LT
D 08 3 O ok

g X | Olayout #1 X +

T
[ builtin:

> S

HE wE K

Properties | Information

Pro

peset “ Delete

8 X

s USE ESC to dear text) Q;;,':
= Properties (headsc . m ;_:] wl
[¥] Cell/Point Array Status
29 Scalars_
RO

= View (Render View . m ..

Edit Axes Grid ..

|:| Center Axes Visbility
Orientation Axes
Orientation Axes Visibiity
Background

[Single color

v]

[. Calor

|'] [Reshore Defau\t]

Renderiewl (W] (E] (0] (][]




[. ParaView 5.0.0-RC2 64-bit

Eile Edit View Sources Filters Tools (Catalyst Macros Help

lllParaView PE BB O 2 FRA KD DG w =
0%t fel@smom <) - RE:dbtddi:BFeed
PRV O 5| O 00 @ 93 5k

Pipeline Browser 8 X | Olayout#1X | + I
B buitn: BB OW EEE RN RUEERAN R Rendenview1 [I)(5)(0)(&) (x|

>Should see a o S
bounding box in
the 3D viewer
window

Properties [W\

Properties & X
Apply || @ Reset 9 Delete
Search ... (use Esc to dear text) u

[ = oot |30 (0 W) -

Cell/Point Array Status
[¥] 3% Scalars_

= Display (Uniforr o

3

m

| styling
Opacity [ 1 =
Specular D 0
(= et 5 € B
D[ Edit Axes Grid ... ] \




lll ParaView

Create an
Isosurface

Select:

- Filters

- Common
- Contour

[l ParaView 5.0.0-RC2 64,5

IFile Edit  View

Properties | Informetin |
Properties ;

I 1 f==
[ = e | 3]
17| Cell/Point Array Status

V] 5% Scalars_

f. 1

|2 -

Representation |oytine
Coloring
@ Sold Color |

R

rces Tools

oty @ Reset [ M [{ 2] -

| = Daplay (nfeer |[D)] B |

Ol Edtadsed..

Material Anafyw

" Quadraticé Points’ © * 7 °

Statistics
Temporal
Alphabetical -

& x

&

D@

—_—

| : IS
l Generate isolines or isosurfaces.
L

'alyn Macros Hdp—: ;
> 1> D 5 meo

T — }{ ® il lb UGS B § &3 3 (

Ctrl+Space

%9 .Group.Datasets. . .

Rendertiew) (0)(8) D) (&)X

e S
“Threshold

‘Extract Subset
iShyph

Stream Trac

er

arp By Vector

‘Extract Level




lll ParaView

» A new object
appeared in the
pipeline browser
(Contour 1)

Contour — Extracts
the points, curves,
or surfaces where
a scalar field is
equal to a user-
defined value.

The surface is
often also called
an isosurface.

M ParaView 5.0.0-RC2 64-bit

r‘file Edit View Sources Filters Tools Catalyst Macros Help
P B P 2 FEA KAD DG o
- RS

radi(Feeca

i T S
[ B 5 7 R O A
Pipeline Browser & X | OlLlayout #1X 1 +
T
@ builtin:
|

=

RenderView1 [=3{f=3E3)

Properties | Information |

Properties g X

arch ... (use Esc to dear text) m

Searct
804

Contour By [ o Scalars_ v ‘\

Compute Normals
[7] Compute Gradients
[~] Compute Scalars
[V] Generate Triangles

m

Isosurfaces
Value Range: [0, 4095]

1 20475

o ]300
@@

D[ Edit Axes Grid ... ]

7] Pambme Avimn Vimihilib,




lll ParaView

M ParaView 5.0.0-RC2 64-bit

rEi!e Edit View Sources Filters Tools Catalyst Macros Help

pe B8 »a

2 FENKAD DT mwmeo

TREEsds gL Feed

»Value Range for
the data set is

2%
[ & O
Pipeline Browser
Ij builtin:

f@ @f m)

now visible

Properties | Information |

Properties

Search ... (use Esc to dear text)

= [5)8 5

Contour By [ o Scalars_

Compute Normals
[7] Compute Gradients
[~ Compute Scalars
[V] Generate Triangles
Isosurfaces

m

Value Range: [0, 4095]

1 20475

B[S

B
(= o |3 & @

D{ Edit Axes Grid ...

7] Pambme Avimn Vimihilib,

RenderView1 [=3{f=3E3)




Pipehne Browser 7 X

Ilparaview - %

»Value Range for the data
setis [0, 4095 ] "T

»Only one value is showing:
2047.5

Properties Information

1Properties g X
(Fa) 0w | FE=@
Search ... {use Esc to dear text)

= Properties (Cor m x:,J mii it

Contour By [ o Scalars_ ,]

‘ Compute Normals
[] compute Gradients
[] compute Scalars
Generate Triangles
Isosurfaces
Value Range: [0, 4095]

1 20475

 XE))E




Pipeline Browser & X | Olayout #1 X
1

lIlParaView : E B %08 HEE

»Value Range for the data
setis [0, 4095 ] |

»Only one value is showing:

2047.5

> Click Apply to see what i, B
points, curves, or surfaces [properties 8 x
in the dataset have a value - =T 9]
of 2047.5

Seard h .. {use ES to clear text)
Properties (Cor ﬂ m o AN |

Contour By [ o Scalars_ ,]

‘ Compute Normals
[] compute Gradients
[] compute Scalars
Generate Triangles
Isosurfaces
Value Range: [0, 4095]

1 20475

 XE))E




lll ParaView

»If you do not
see anything
in the 3D
window click
the eye icon
next to
Contourl in
the Pipeline
Browser

»This allows
you to toggle
between views
in the 3D
Viewer

r

M ParaView 5.0.0-RC2 64-bit

File Edit View Sources Filters Tools

pE B wa 2 kN KA> DD
B 8 & ¢ fe[@sidcor ] o) furtee ) [ B wdk&l«'ﬁ«@@» (BFle® G
H 90 PRPOEL0 R 100 ® ok

Catalyst Macros Help

Time: 0

Pipeline Browser & X | Olayout #1 X 1 + I
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ﬁ builtin: RenderView1 (=)

|
@ W headsq.vti
[~ ) ‘ontourl

Properties Information |

Properties Sxi
M@
Bl e

Contour By[ o Scalars_ I

Apply &) Reset

o dear text)

[¥] Compute Normals
[] compute Gradients
[7] Compute Scalars
[¥] Generate Triangles

m

Isosurfaces
Value Range: [0, 4095]

1 20475

5

Coloring

@ Solid Color X




Visually Explore Dataset

POLYTECHNIC



Visually Explore Dataset

POLYTECHNIC



lll ParaView

[. ParaView 5.0.0-RC2 64-bit
Eile Edit View Sources Filters Tools Catalyst Macros Help

pE B wa 2 FEN KA>PDPIS

Time: 0

You should be
here

19003

U %% fe[0smoe -

TN - (e AL&.KL.%.M» FeeG

0® R
[ B2 & QF 6

Pipeline Browser

LEEEES]

RenderViewl

T
@ builtin: LA
|

@ @headsq.vti

» S

Pipeline Browser

- Two objects

- Value Range
[0, 4095]

Properties Information

Properties

o )@ | (R 1
Search ... (use Esc to dear text)

Emwm-m--,

Contour By[ o Scalars_

Exr

[¥] Compute Normals
[ Compute Gradients
[7] Compute Scalars
[¥] Generate Triangles

m

Isosurfaces
Value Range: [0, 4095] ’

1 20475

2] (-] (@)

=3 Display (Geome . - .

Coloring

@ solid Color 2 vl




Isosurfaces

» Select 2047.5 showing in
Value Range

» Delete that value (click the
minus button to remove
all values)

Properties Information

Properties

f X

o apply || @ Reset || 96 Delete |[ 2 |

Search ... {use Esc to dear text) o

=3 Properties (Cor

v

ENCY 1A

Contour By[ o Scalars_ ']

Compute Mormals

Compute Scalars

Isosurfaces

Compute Gradients

Generate Triangles

m

Value Range: [0, 4095]

= Display (Geome

ENENEINE]

Representation [mﬁce - ]

Coloring

| @ Solid Color

v]| -]
il




Isosurfaces

> Click the button below the minus
button to: Add a Range Of Values

Properties Information

Properties B X

[ F ooty ][ @Reset |[ 3¢ pekte ][ 2 ]

| Search ... (use Esc to dear text)
= Properties {(Cor c;jﬂ o |
Contour By [ o Scalars_ v]

Compute Mormals
[7] compute Gradients
[] Compute Scalars
Generate Triangles

m

Isosurfaces
Value Range: [0, 4095]

» Should see the Add Range
Window
» Use this window to set the
range of values
» For this tutorial
» Min: 0
» Max: 4095
» Feel free to pay around with
the range (between 0 and
4905)

From 0
To 4095

Steps 10

[ Use Logarithmic Scale




Isosurfaces

> Click the button below the minus
button to: Add a Range Of Values

Properties Information

Properties B X

[ F ooty ][ @Reset |[ 3¢ pekte ][ 2 ]

Search ... (use Esc to dear text)
= Properties {(Cor oy uf.'] o |
Contour By [ o Scalars_ v]

Compute Mormals
[7] compute Gradients
[] Compute Scalars
Generate Triangles

m

Isosurfaces
Value Range: [0, 4095]

» Should see the Add Range

Window
» Use this window to set the
range of values
» For this tutorial
» Min: 0
» Max: 4095
» Feel free to pay around with
the range (between 0 and
4905)

> Click OK

Steps 10

[ Use Logarithmic Scale

i Ok I Cancel




Isosurfaces

Properties Information

Properties g X
[ aooly |[ @ Reset |[ 3 Delete |[ 2]
Search ... {use Esc to dear text)

Value Range: [0, 4095]

> Notice the Value Range: [0, 4095] — | ===~

» There are 10 values (steps)
showing values between 0 and
4095

<

-

1 0

2 455

3 910

4 1365

5 1820

6 2275

7 2730

8 3185

9 3a40

10 4085

(]
=)

m

) (x~) (@]

PURDUE
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Representation |gyrface -
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M ParaView 5.0.0-RC2 64-bit
i‘—File Edit View Sources Filters Tools (Catalyst Macros Help
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Pipeline Browser & X | Olayout#1 X
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@ @ headsq.vti

- SE

Properties Information
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Explore the rendering. ..

Properties Information
Information B X

Statistics

| Type: Palygonal Mesh
Mumber of Cells: 2292159
Mumber of Points: 1151862
Memaory: 99 MB

Data Arrays

Mame Data Type Data Ranges

2 Mormals float [-1, 0.999998], [-0...
Bounds

| ¥range: 7.44to 243 (delta: 2368)
Y range: 0 to 234 (delta: 234)
Zrange: 0 to 186 (delta: 138)
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You should be here...

Contour — Extracts
the points, curves,
or surfaces where
a scalar field is
equal to a user-
defined value.

The surface is
often also called
an isosurface.

[. ParaView 5.0.0-RC2 64-bit =i |
rgﬂe Edit View Sources Filters Tools Catalyst Macros Help
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Properties

" Apply

Search . e Esc to

8 X
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Explore the tiata set

Set Value Range

ron sy Lunarcouze_

1500
2500
2999
3500
2000
3000

2500
3500
3500
4000
2999
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10
20
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10
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Reset Values

Click red X — Remove all entries

Isosurfaces

Value Range: [0, 4035]

1 3000 %

2 311

3 322

4 3333

5 3444

6 3555

7 3666

g 3777

9 3888

10 3999 %) x-] [(&]
= Display (Geome |[(D] (@ | [@] [Id]

Click Add a range of values button

Isosurfaces
Value Range: [0, 4095]

i |
%) x] (2]
= Display (Geome |@||E||ﬂ||u|.§

Click OK
Click Apply




Reset Values

Click red X — Remove all entries

EFE

Isosurfaces
Value Range: [0, 4095]
1 3000 E]
2 31 E]
3 3222
4 3333
5 3444
6 3555
7 3666
&
9

3888

10 3999 C:EEE
= Display (Geome |[(D] | B | (@] (4]

Click Add a range of values button

Isosurfaces
Value Range: [0, 4095]

i |
%) x] (2]
= Display (Geome |@||E||ﬂ||u|.§

Click OK
Click Apply




Reset Values

Click red X — Remove all entries

Isosurfaces
Value Range: [0, 4095]

1 3000

3111

U

3222
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2444

3666

2

3

4

5

6 3555
7

8 33N
9
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10 3999 C@

= Display (Geome [@HEHEHH]

Click Add a range of values button

Isosurfaces
Value Range: [0, 4095]

m

= Display (Geome ||[[D| @ | &[]

Click OK
Click Apply




You should he here
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Clin Isosuriace

» CLIP - Intersects the geometry with a
@ half space.

> The effect is to remove all the
geometry on one side of a user-
defined plane.
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Glip Isosurface
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» Clipping plane P:D
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horizontal arrow)

Properties Information

Properties 8 X
e |[Mosee,
Search ... {use Esc to dear text)

Properties (Clip sl =
oee
| [¥] show Plane

Note: Use 'P' key to pick origin position on
mesh
[~] snap Picked Point on Mesh Point
Origin  125.3777155 116.9024353 92.88888549
Normal 1 0 0

[ xNomal ][ ResetBounds |

¥ Normal
C_zvoma__
[ [ Camera Normal ][ Center on Bounds ] El
Reset Camera to Normal
[7] inside Out
[7] Crinkle dip

m

D0 e |-
[ = view Renderv | (@] (@] [&] (] -

=3 Display

RenderViewl @ @




Glip Isosurface
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pE BB oa 2 &N KAD> DD B iwmeo 0
»>Select thearrow | ;. .. TEEGSER

point (arrow E90PRPOS20bB Rews

v Representation

sai/BFeea
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» Rotate (drag) the

arrow point until
the arrow is
pointing out of
the screen
toward you)

Properties Ir i

Properties 8 X
&) Reset
Search ... {use Esc to dear text)

Cip Type

| [¥] show Plane
Note: Use 'P' key to pick origin position on
mesh
[~] snap Picked Point on Mesh Point
Origin  125.3777155 116.9024353 92.88888549

m

Normal 1 0 0

[ xNomal ][ ResetBounds |
¥ Normal

T

[ [ Camera Normal ][ Center on Bounds ]

Reset Camera to Normal

[7] inside Out

[7] Crinkle dip

=3 Display
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RenderViewl @ @
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Properties
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[¥] show Plane

Note: Use 'P' key to pick origin position on
mesh

[7] snap Picked Point on Mesh Point
Origin  125,3777155 116.9024353 92.88888549

Y Normal
Z Normal

Reset Camera to Normal

[7] inside Out
[T] crinkle dlip
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( X Normal )| ResetBounds |
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Glip Isosurface

»Make sure the
eye icon is not
greyed out on
the Clip1
object in the
Pipeline
Browser

"
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Properties F X
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[¥] Show Plane

Note: Use 'P' key to pick origin position on
mesh =
[~] snap Picked Point on Mesh Point

Origin  125.3777155 116.9024353 92.88888549
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[7] Inside Out
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RenderViewl @ @

Depending on where you placed the clipping
plane the results may be easily seen: see
clipped ears; and area round neck




Glip Isosurface

Rotating the view reveals
the clipped isosurface
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File Edit View Sources Filters Tools (Catalyst Macros
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Inside Out Property

» If this property

issetto O,
then clip filter
will return
that portion of
the dataset
that lies within
the clip
function.

>If set to 1, the
portions of the
dataset that
lie outside the
clip function
will be
returned
instead

[ M ParaView 5.0.0-RC2 64-bit
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Properties Information |

| = Properties (Clip . @ . .
-

| [¥] Show Plane

Note: Use 'P' key to pick origin position on
mesh

[ snap Picked Point on Mesh Paint

Origin  125.3777155 116.9024353 92.88888549
Normal 0.029618929 0.999472404 -0.01332733+
[ xNormal ) ResetBounds |

Y Normal
| Z Normal

][ Center on Bounds ]

[ Camera Normal

pera to Normal

[¥] 1nside Out
=3 Display (Unstru .

Representation [Surface = ]

Properties g X
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slice Isosuriace

» Click the eye icon
next to Clipl in the
pipeline browser
(hide the clip plot)

»Select Contour 1

Properties | Information
|

Properties (4

F Apply D Reset 9 Delete
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slice Isosuriace

M ParaView 5.0.0-RC2 64-bit

Select

> Filters
» Common

> Slice

'w File Edit View Sourc

ols Catalyst Macros -Help

o e B,
%
Eoem®

Pipeline Browser

1

builtin: -

. :
@ @headsq.vt

L 2 Contour
P ﬁdipl

Recent
AMR

Annotation

Common

Material Analyisis

- QuadraturePoints

Statistics

Temporal

Alphabetical

Search... -

»
4

.
Properties

Information

-

Properties

¥ Apply || (@ Reset

3 Delete

& X

L |

~ Ctrl+Space:

Time: |

(Surfece.
D B OF OK
E-; Calculator

% Contour .

Extract Subset

© Glyph

o= Stream Tracer

®  WarpByVector
© Group Datasets

Extract Level
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Pipeline Browser
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|
@ @ headsq.vti
@ ﬁ Contour1

Properties Information

X

Properties =
[ Apply D Reset || 38 Delete
Search ... {use Esc to dear text)

Properties (Slio AN
[¥] Show Plane

Note: Use 'P' key to pick origin position on

|

73
i
3

-

[~ snap Picked Point on Mesh Point

Origin  125,3777155 116.9024353 92.88888549
Normal 1 0 0

X Normal )| ResetBounds |
Y Normal

m

Camera Normal ][ Center on Bounds ] R

Reset Camera to Normal

[7] crinkle slice
[¥] Triangulate the slice

= Display D0 e | E

= View (Render V @ o @@'

T " e | i o Ry 2
[ builtin: & DM AR KR BE R A2

RenderView1 (II)(B)(@)(#](X]

Drag arrow point around to point
out of screen toward you.
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C to dear text) a
Skce Type

Show Plane
Note: Use 'P' key to pick origin position on
mesh

[~ snap Picked Point on Mesh Point
Origin  125.3777155 116.9024353 92.88888549

m

Normal 0.009954422 6.999 123327 -0.04066307¢

[ XNormal J[ ResetBounds |
¥ Normal

[ Camera Normal H Center on Bounds ]

Reset Camera to Normal

[7] Crinkle slice

Triangulate the slice

(= |B)®)@)E
[ = view Renderv | (@] (@ [@] (] ~

RenderView1 @Ex]
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File Edit View Sources Filters Tools (Catalyst Macros Help

pE B owa 2 FEN KAD> D> mo e

0 B 5 fe(@smom ] —xm 1431,3;;3.@&.. BlefcXe
EOQPRTOESELD & ;

Pipeline Browser & X | Olayout #1 X

B buitin: B N AN RA A7 Renderview1 (@)(E]@)(&(X]
L

@ P headsq.vti

@ ¢ Contour1

> r:@ Clip1
R o sice1

SLICE — Intersects the
geometry with a plane.
The effect is similar to
clipping except that all
that remains is the
geometry where the
plane is located.




PIPELINE BROWSER

Pipeline Browser

ﬁ builtin:
LF -Iheadsq.'uﬁ
L ] -ICuntourl
@ |:-
@ g Slice1

headsq.vti

Slicel
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PIPELINE BROWSER

Q. How do we combine

(show) the Clip and Slice views at
the same time?
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Pipeline Browser

File Edit View Sources Filters
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O Layout #1 X

Tools
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[ builtin:
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@ mheadsq.vﬁ

@ te

@ @ slicer

Properties Information

Properties
Apply

Search ... {use Esc to dear text)

Clip Type
[¥] Show Plane

[”] snap Picked Point on Mesh Paint

Sx'

EMHE.Q-.—

Note: Use 'P' key to pick origin position on
mesh

Origin 125, 3777155 116. 9024353 92. 883885491
Normal 0.029618929 0.999472404 -0.01332783A!

[ xvoma |

ResetBounds |

Y Normal
Z Normal

[ Camera Normal

][ Center on Bounds ]

Reset Camera to Normal

[¥] Inside Out
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Many Options to Save Your Work

IFiie| Edit View Sources Filters

Ctrl+0O

Rece_nt Files

Lnad State...
&“ StatEtt "

Saw.f Screenshot...
Expct:rt Scene...

S.aw.:f Animation...

. Save Geometry... . . . .

Load Window Layout...i
Save Window Layout...

Disconnect

Exit .
Expart Cinema...




save Your Work

[ File | Edit View Sources Filters
‘) Open.. . Ctrl+0

Rec:nt Files : »

Save State

save the state of the visualization

pipeline itself, Load State...
including all the pipeline modules, - Save State
views, their layout, and their S

properties. % SaveData... . .. . . Ctrl+S
o o [® Save Screenshot...
This is referred to as the application S —
state or, |
just, state. w% SaveAnimation..
. Save Geometry... .. . ... ... ...
In paraview, you can save the state — }
using the File Save State. . . menu Load Window Layout...
option. Save Window Layout...
@ Connect...
Conversely, to load a saved state ¥ Comect. o
- - ‘% Disconnect
file, you can use File Load State. . .. b : |
Exit . . Ctrl+Q
Expart Cinema... Z DUE
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Save Data

You can save the dataset
produced by any pipeline
module in ParaView, including
sources, readers, and filters.

To save the dataset in
paraview, begin by selecting
the pipeline module in the
Pipeline browser to make it the
active source.

For modules with multiple
output ports, select the output
port producing the dataset of
Interest.

To save the dataset, use the

File Save Data menu or the
button in the Main Controls
toolbar. You can also use the
keyboard shortcut Ctrl + S

(or+S).

The Save File dialog will allow
you to select the filename and
the file format. The available

list of file formats depends on
the type of the dataset you are
trying to save.

PURDUE
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Save Screenshot

To save the render image

from a view in paraview, use

the File Save Screenshot
menu option. This will pop
up the Save

Screenshot Options dialog
(Figure 8.3).

This dialog allows you to
select various image
parameters, such as image

resolution and image quality

(which depends on the file
format chosen).

Save Screenshot Options X

‘Save only selected view
Select resolution for the image to save

1230 x | 944 15

Select image quality (if applicable)
0 - low quality, 100 - high quality

= —{) [ 100

Override Color Palette
Current Palette |~
Stereo Mode (if applicable)

No Stereo -

Ok I Cancel

PURDUE
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Save Screenshot continued . ..

Save Screenshot Options X

iSave only seletted view

The dialog also provides an
option to change the color palette
to use to save the image using
Override Color Palette.

By default, paraview will save
rendered results from the active
view. Optionally, you can save an
Image comprising of all

the views layed out exactly as on
the screen by unchecking the
Save only selected view button.

Select resolution for the image to save

11230 | x | 944 | (8]

Select image quality (if applicable)
0 - low quality, 100 - high quality

0 [100

Override Color Palette

Current Palette [+]
Stereo Mode (if applicable)

No Stereo v

l Ok \ Cancel
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In preparation for the next section

You should be here

ParaView 5.0.0-RC2 64 [ [ E ety
> Delete all objects inthe  |T=conorioss oo
. . TR - e RE s Ld ik Feea
Pipeline Browser TTILITYIPT ”
Poeine Browser 8 x [ Olsyouts1x | 4 |
8 buitn: [EXIEY W1 Renderview1 (1)E)0)(8)(X)

» Select an object in the
Pipeline Browser

> Click the Delete button —
(or right click, then H
Delete) e

> To select multiple objects  |== .
press and hold the CTRL
key while selecting
objects
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Getting Your Data Into UTK

PURDUE
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VTK (http://www.vtk.org/VTK/img/file-formats.pdf)

EnSight
Plot3D
Various polygonal formats

Users can write data readers to extend support
to other formats

Conversion to the VTK format is straightforward

PURDUE
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http://www.vtk.org/VTK/img/file-formats.pdf

UTK Simple Legacy Format

VTK simple legacy format (http://www.vtk.org/VTK/img/file-formats.pdf)

* ASCllor blnary # vtk DataFile Version 2.0 10
- Reall 1d
« Supports all VTK grid  ascit fﬁ%ﬁﬁy jfa?@

DATASET npe

types

:|(4)

» Easiest for data PONIDATAY T
conversion CELL DATA» |
Part 1: Header Part 4: Ge Gm;try topology. TVpe is one of:

STRUCTURED POINTS
STRUCTURED GRID
UNSTRUCTURED GRID

Part 2: Title (256 characters maximum, termi-
nated with newline ‘\ n character)

Part 3: Data type. either ASCII or BINARY POLYDATA
RECTILINEAR GRID
Part 5: Dataset attributes. The number of data FIELD

items 77 of each type must match the number

of points or cells in the dataset. (If fype 15
FIELD, powmnt and cell data should be omitted.

PURDUE
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http://www.vtk.org/VTK/img/file-formats.pdf

Simulated Temperature

The data

 Simulated
temperature
values

« Sample size:
100 x 100

 Rectilinear Grid

100 100
20.18
20.34
20.53
20.70
20.846
21.02
21.17
21.31
21.44
21.56
21.66
21.76
21.85
21.52
21.949
22.04
22.09
22.12
22.15
22.17
22.18
22.18
22.18
22.17
22.15
22.13
22.11
22.08

20.34
20.72
21.07
21.41
21.74
22.05
22.35
22.63
22.88
23.12
23.34
23.53
23.70
23.85
23.98
24.09
24.18
24.25
24.30
24.34
24.348
24.37
24.348
24.34
24.31
24.27
24.23
24.17

20.54
21.08
21.81
22.13
22.682
23.10
23.54
23.96
24.35
24.71
25.04
25.33
25.58
25.81
26.00
26.16
26.29
26.40
26.48
26.53
26.56
26.57
26.55
26.53
26.48
26.42
268.35
26.27

20.73
21.44
22.17
22.86
23.53
24.17
24.77
25.33
25.85
26.33
26.77
27.15
27.50
27.80
28.05
28.26
28.44
28.57
28.4a7
28.74
28.78
28.78
28.77
28.73
28.66
28.58
28.49
28.37

20.93
21.85
22.75
23.63
24.47
25.28
26.03
26.74
27.40
28.00
28.54
29.03
29.44
29.83
30.14
30.41
30.82
30.78
30.91
30.98
31.03
31.03
31.400
30.95
30.87
30.74
30.64
30.49

21.13 21.35 21.58
22.24 22.68 23.14
23.34 23.99 24.87
24.42 25.246 268.15
25.45 26.48 27.597
26.43 27.84 28.92
27.35 28.73 30.18
28.21 29.74 31.35
29.00 30.487 32.43
29.73 31.52 33.41
30.38 32.29 34.28
30.94 32.94 35.05
31.47 33.54 35.73
3l1.31 34.07 36.31
32.2% 34.50 36.7%
32.80 34.84 37.18
32.85 35.14 37.50
33.04 35.35 37.73
33.18 35.51 37.89
33.27 35.80 37.99
33.31 35.64 38.02
33.31 35.83 38.00
33.27 35.58 37.92
33.20 35.48 37.80
33.10 35.35 37.865
32.97 35.1%9 37.45
32.81 35.00 37.23
32.83 34.79 36.97
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vtk Format

# vtk DataFile Version 2.0 T
_ _ Really cool data 1
# vtk DataFile Version 2.0 ASCII | BINARY @)
Rectilinear grid of temperature values DATASET npe @
ASCII POINT DATA»n
DATASET RECTILINEAR_GRID (5)
CELL DATA »
Part 1: Header Part 4: Geometry/topology. 7ipé€ 1s one of*

STRUCTURED POINTS
STRUCTURED GRID
UNSTRUCTURED GRID
DPOLYDATA
RECTILINEAR GRID
FIELD

Part 2: Title (256 characters maximum, termi-
nated with newline ‘\ n character)

Part 3: Data type, either ASCII or BINARY

Part 5: Dataset attributes. The number of data
items 71 of each type must match the number

of pomts or cells in the dataset. (If fype 1s
FIELD, poimnt and cell data should be omutted.

PURDUE
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vik Format

# vtk DataFile Version 2.0 * o )
Rectilinear grid of temperature values Although this is a 2D grid,
ASCII the z-coordinate must be
% B;A\JQEEITO'T\'ESCJAB'TOE&A‘?—GR'D included and represented in
the DIMENSIONS

X_COORDINATES 100 float

012345678910 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28
29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52
53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 /3 74 75 76
77 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94 95 96 97 98 99

Y_COORDINATES 100 float

012345678910 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28
29 30 31 32 33 34 35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52
53 54 55 56 57 58 59 60 61 62 63 64 65 66 67 68 69 70 71 72 73 74 75 76
77 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94 95 96 97 98 99

% Z COORDINATES 1 float
0

PURDUE
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# vtk DataFile Version 2.0

Rectilinear grid of temperature values
ASCII

DATASET RECTILINEAR_GRID

DIMENSIONS 100 100 1
X_COORDINATES 100 float

012345678910 11 12
29 30 31 32 33 34 35 36
53 54 55 56 57 58 59 60
77 78 79 80 81 82 83 84

Y_COORDINATES 100 float

012345678910 11 12
29 30 31 32 33 34 35 36
53 54 55 56 57 58 59 60
77 78 79 80 81 82 83 84

Z_COORDINATES 1 float
0
K POINT_DATA 10000

SCALARS temperature float

LOOKUP_TABLE default

16 17 18 19 20 21
40 41 42 43 44 45
64 65 66 67 68 69
88 89 90 91 92 93

16 17 18 19 20 21
40 41 42 43 44 45
64 65 66 67 68 69
88 89 90 91 92 93

26 27 28
74 75 76

26 27 28
74 75 76

* x-dimension * y-dimension * z-dimension

PURDUE
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vik Format

# vtk DataFile Version 2.0

Rectilinear grid of temperature values
ASCII

DATASET RECTILINEAR_GRID
DIMENSIONS 100 100 1
X_COORDINATES 100 float

012345678910 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34
35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64
65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94
95 96 97 98 99

Y_COORDINATES 100 float

012345678910 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34
35 36 37 38 39 40 41 42 43 44 45 46 47 48 49 50 51 52 53 54 55 56 57 58 59 60 61 62 63 64
65 66 67 68 69 70 71 72 73 74 75 76 77 78 79 80 81 82 83 84 85 86 87 88 89 90 91 92 93 94
95 96 97 98 99

Z_COORDINATES 1 float

0

POINT_DATA 10000
SCALARS temperature float
LOOKUP_TABLE default

20.18 20.36 20.54 20.73 20.93 21.13 21.35 21.58 21.82 22.09 22.38 22.70 23.06 23.46 23.92 24.44 25.05 25.77
26.63 27.68 28.99 30.68 32.90 35.99 40.50 47.61 60.00 84.65 142.03 300.00 300.00 300.00 300.00 300.00
300.00 300.00 300.00 289.04 288.50 287.82
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SAMPLE DATA FILE

Data Files

Header.txt
xCoordinates.txt
yCoordinates.txt
zCoordinates.txt
lookUpTable.txt

Task:

Combine these files into
one file and save

SampleData.vkt

PURDUE
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 Open data file
(the file that
you just
created and

Propertes | Display_| Information |

Properbe

saved A0 ) (s )
e Click Apply




EXERGISE: VISUALIZE SAMPLE DATA

Add Contour Plot Set the range of values
From 20.01
To: 300
Step 10
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Fipeline Erowser

What should the

pipeline browser look
like? Split Window

a

Properties

A Apply
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